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Program 

Software

Operating System

A program is a set of instructions or steps to complete a work. 

 A software is set of related programs designed to perform a group task. Software is categorized into two types-

As the name suggests system program is responsible for running of the overall computer system. These 

days windows 98, 2000,XP,windows7, windows 8, Linux etc. represent the most popular operating system.

Application software can function only when your computer system has the required system software. 

Application software includes MS-Office, adobe PageMaker, CorelDraw, Corel word perfect, AutoCAD and 

countless other programs for performing different functions.

An operating system consist of a set of program. These programs manages a computer hardware and 

software resources. An operating system is the most essential system software that utilizes the computer 

system resources effectively and acts as an interface between the user and the hardware. An operating system 

is the most essential system software that manages the operation of a computer. Without an operating system, 

it is not possible to use the computer. 

It manages CPU operations, input /output  operations, storage resources, drivers support services and 

controls various devices.

Some examples of operating  system are MS DOS, UNIX, MS 

WINDOWS, Linux, Fedora etc.

In MS DOS, a user has to remember and type the 

syntaxes and command to work over operating system. The 

windows operating system overcome the need for typing 

and remembering the commands by using a graphics 

interface. In other words windows operating system is 

known as operating system with a Graphic User Interface 

(GUI).

In windows we interact with icons. These icons are 

graphic symbols. They represent various programs.

1. System Software

2. Application Software

01

Chapter - 1Chapter - 1 AN INTRODUCTION TO WINDOWS
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Both the operating system, normally MS DOS and windows operating system, were developed by 

Microsoft corporation where the windows operating system also included MS DOS commands.

The first screen that you see after window has been activated is called the desktop, this really works as a 

typical desktop. It contains several original icons like my computer, my document, my briefcase, network 

neighborhood, recycle bin etc. Each icons represents an objects, such as a software, folder or program.

)

A computer icon on desktop represents MY 

COMPUTER. To activate my computer you have to double 

click on the icon. You can learn almost everything about 

the computer through this topic. Once you select my 

computer the icon's will be displayed in the my computer 

dialog box as shown fig.1.1

1. Icons representing all the drives of the computer 

i.e. c: drive, d: drive, floppy drive.

2. Printer folder

3. Control Panel.

Desktop 

My Computer

(Desktop figure

(Figure 1.1)
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Task Bar 

The Basic Components Of Windows

The task bar is normally visible at the bottom of the screen/desktop to keep tract of the activated 

application. The start button is located at the left of the taskbar. It can also be moved to the other sides of 

the screen.

The start button can comply any task, for example, you can start program, open document, customize your 

system, get help, search for any items on your computer etc.

 Some of the commands on it have a right-faced arrow. This means that different options are available with 

them. This bar is generally found at the bottom of screen. The taskbar contains start button, clock and some 

other toolbars.

Let us quickly look at the components of a typical window:

Taskbar figure

(Figure 1.2)
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1) Title Bar :

2) Menu Bar :

3) Scroll Bar :

4) Maximise Button :

5) Minimise Button :

6) Close Button :

7) Restore Button :

 The title bar is always located at the top of the windows. It shows the name of the program 

that is being executed. It also shows the name of the currently opened file.

 Menu bar is located under the title bar and it shows the available menus.

 They are used to move through a document or list when the entire document or list does not 

fit in the window. 

 It is located in the upper right corner of the screen and it controls the size of the 

windows.

 It is located in the upper right corner of the screen towards left of maximize button. It 

helps to minimize the whole application and show it in the reduced form on the taskbar.

 This button is present in the upper right corner of the screen. It allows the user to 

shutdown the opened application.

 The maximize button is replaced by the restore button after the window is enlarged. 

Click this button return the window in its previous size.

Folder is just like a bag that holds your files.

Once you have learned the characteristic of folder and files, it will be easier for you to create a folder.

1. Click on the right mouse button on the desktop.

2. A context menu will appear.

3. Click on new option.

4. Now, choose folder option.

5. When you click on the folder, a new folder will be created on the desktop.

6. Now the cursor is blinking inside a folder icon, just type the name of this new folder.

It is just like a dustbin. In a home where all the unwanted / waste material is thrown, computer also has a 

dustbin known as recycle bin where all deleted material is stored. 

(See fig. 1.2.)

Create A New Folder/Directory

To Create a Folder follows these steps

Recycle Bin
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A file when deleted goes to recycle bin. It can be restored from recycle bin, if required. But when a file is 

deleted from recycle bin, it can not be restored. It has lost permanently . As shown in 

The label or name of a disk/drive can be changed using following steps :

1. Select the disk or drive which you want to change the label.

2. Right click on the mouse button on that drive.

3. A context menu appears.

4. Now, select properties in context menu.

5. Properties window is appear.

6. Then write the new name in label option.

7. Click on apply or ok button.

Figure. 1.3

Change The Name / Label On A Disk Or Drive

(Figure 1.3)
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Capacity Of a Disk 

Determine The Space Used By Individual File

Rename A File Or Folder 

Delete A File / Directory

Now days the medium of storage are available in different capabilities. The description is given below:

When we make any file, there should be some space covered by that file. 

To check the space covered by that file follow these steps:

1. Right click on the mouse button of the file.

2. A context menu appears.

3. Now, select properties in context menu.

4. Properties window is appear.

5. Now you can see the size of the file.

To rename a file or folder follow these steps:

1. Select the file, which you want to be renamed.

2. Right click on the mouse button of the file menu.

3. A context menu appears.

4. Now, select rename option in context menu.

5. Then write the new name.

6. Now press enter. 

To delete a file or folder follow these steps:

1. Select the file, which you want to delete.

2. Right click on the mouse button of the file menu.

3. A context menu appears.

4. Now, select delete option in context menu.

5. The dialog box appears, then click on yes button.

6. The file goes out in the recycle bin. 

MEDIUM CAPABLITY

Hard Disk 320 GB to 1 TB

Pen Drive 2 GB to 32 GB

Compact Disk About 700 MB

Digital versatile Disk (DVD) About 4.3 GB

Blue Ray Disk 8 GB to 24 GB 
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Find A File

1. Multiple Choice Questions :

To find a file you may follow the steps as given below

1. Now, enter the file name in the named box as indicated here

2. Now, a number of files matching the file name will be displayed.

Find window is shown in figure 1.4.

a) Operating System b) Application System

c) Operating Software d) Database software

Exercise

1. Windows is the type of software-

(Fig 1.4)
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2. Recycle bin is used to –

a) Store old files b) Store New files

c) Store deleted files d) store created files

1. First screen, which appears when window has been activated, is called____________.

2. _____________________Allows to recover deleted files.

3. The find utility can be used to search for files and folders. Choosing _______________________from 

the start menu can start find.

4. The top most bar in any application window is the ____________________, it display the name of the 

document or application.

5. By clicking the ____________________button it restore the application window in its original size.

1. Can you empty recycle bin.

2. Can you find a file in Windows?

3. Task bar properties cannot be changed in windows.

4. All deleted material could not be restored from recycle bin.

5. Files and folder in windows usually have different icons.

6. Clicking the minimize button reduces the application to an application box taskbar thereby halting its 

execution.

1. What is an operating system?

2. What is Desktop?

3. What is task bar? 

4. What are the functions of My computer? 

5. How do you find a topic from the window help menu?

6. What is folder? Explain how to create a folder?

7. Write the step to rename file & folder.

2. Fill in the blanks :

3. State True Or False :

4. Question And Answers :
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Overview of PowerPoint

Starting PowerPoint 

Choosing font style, color and text

PowerPoint is the component of Microsoft Office that is used to create professional- quality 

presentations. PowerPoint components can be used to work on slides, organize presentation contents with 

outlines, and generate speaker notes and audience handouts. PowerPoint 2007 helps you to structure the 

ideas and information that you want to convey to your audience. It allows you to create the contents of your 

presentation by typing the text and inserting pictures, sounds and animations. 

The steps to activate PowerPoint:

1. Click the Start button in the taskbar.

2. Select the All Programs option from the Start menu.

3. Click the MS-office-> Microsoft PowerPoint 

To change font setting follows these steps:

1. Select the text, which you want to change.

2. Select Font; now select font style, size and color from menu.

3. Shadow option of the effect area adds a shadow at the bottom and the right side of each character.

Chapter - 2Chapter - 2 POWERPOINT

(Fig 2.1)
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4. Emboss option gives the text an appearance for raised letters by using a light color for the character 

and a faint shadow behind each character.

5. Subscript option drops a selected character slightly below the normal line level as in H O and the 2

2superscript option raises a selected character as in X Y.

6. Select the format, which you want and click on OK button.

This will help you to set the spacing between lines and spaces before and after paragraph. For the same 

purpose follow these steps:

Changing line and paragraph spacing

(Fig 2.2)

(Fig 2.3)
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1. Select the text for which you want to change line or paragraph spacing.

2. Select line spacing option from Home menu, then the Paragraph option is displayed.

3. Then choose the Indent and spacing option.

When we run a presentation, text is generally left aligned for paragraph and centered for titles. We can 

adjust the text by the following steps:

1. Select paragraph to align the text.

2. Now select  Line spacing toolbar and select line spacing option

3. left or right or center alignment options from the window as per the requirement. 

To add bullets to the text follow these steps:

1. Put the cursor at the point on the 

text  and  select  bullets  and 

numbering option.

2. Now from the appeared dialog list 

box select the symbol of bullet that 

you want to use.

3. Color and size of the bullet also may 

be changed from the color and size 

box and click on OK button.

Text Alignment

Adding bullets to the text

(Fig 2.4)

(Fig 2.5)
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Fill colors and line colors

Using Shading and Pattern

How to add a Gradient

To fill colors in an object follow these steps:

1. Select the object to fill color.

2. Select the colors and lines option from the Format toolbar, now 

shape fills dialog box will be displayed.

3. Now select color and lines tab to display the current fill color in 

fill color box.

4. Click on the arrow to open the fill color drop-down list.

5. Select one of the options from the drop-down list. And click on 

OK button.

The shading and pattern are two effective ways to make the slide look better. 

These are Gradient color and two-color pattern. A gradient is a dark-to-light or light-to-dark variation, which 

can run vertically, horizontally or diagonally from any angle.

To add a gradient follow these steps:

1. Select the object and select Shape Fill option.

2. Select the Gradient option from appeared dialog box.

3. Select the one color or two color or preset options for the gradient.

(Fig 2.6)

(Fig 2.7)
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4. Now select shading styles like Horizontal or Vertical or diagonal-up or diagonal-down or from 

corner or from center options as per the requirement.

5. Now click on OK button.

To apply shadowing to an object, follow these steps:

1. Select the object to add shadow.

2. Click on shadow button from the 

shape effect option.

3. And select the appropriate shadow 

effect or change the shadow settings 

from shadow setting tool bar.

4. Also to set vertical shadow offset 

select nudge shadow up or nudge 

shadow down buttons from the 

shadow setting dialog box.

5. Select appropriate shadow as per 

requirement.

To change the color scheme of a design template, follow these steps:

1. From Design menu select the colors option then the color scheme dialog box will be displayed.

2. Now select the required color scheme.

3. As you select the create new theme color, another dialog box will appear.

4. Now select the item that has the color you want to change and press change color button, then 

a background color dialog box will appear.

5. Now select required color and press OK button.

6. Now click Apply button to apply changes to current slide. In case to change the colors to all the 

slides, click on Apply to all button.

Adding Shadows

Working with color schemes (Fig 2.8)
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Exercise

1. Fill in the blanks :

2. State True or False :

3. Answer the following question :

1. Selection of multiple objects can be done by holding down the ___________ key.

2. Fill color option is found in the ______________ dialog box of format menu
2

3. __________ Option can be selected from ________ raises the letter as   X Y.

1. Text alignment buttons are found on the _________ toolbar.

2. Bullets can be selected from ________ menu.

1. You can change the font style without selecting the text.

2. Line spacing dialog box is used only for line spacing.

3. In text alignment you can align your text in center.

4. By default font style is bold italic.

5. The gradient tab is found in shape effect toolbar.

1. Write down the steps to change the font type of the text.

2. What is Text Alignment? Also write types of alignment.

3. How can you Add bullets to the text, write steps?

4. What are Gradients?

5. In a PowerPoint presentation, how can you add shadow?

6. What are the steps to change line and paragraph spacing?

7. What are steps to change the color of the text?

(Fig 2.9)
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How to use templates

How to get a template

PowerPoint provides templates to make it easy to create a professional looking presentation.  PowerPoint's 

templates are designed by Microsoft to make our life colorful and effective.

To get a template, follow these steps:

1. First, start the PowerPoint and click on office button  ® New Presentation option.

2. As the installed template option is selected, one more dialog box will appear.

3. Now from the new presentation dialog box, select one desired tab.

Chapter - 3Chapter - 3 POWERPOINT (Contd.)

(Fig 3.1)



16

Blank and Recent

Installed Templates

Installed Themes

The Blank and Recent option is used to create a blank presentation.

These templates are used for professional designing purpose on which you can base a presentation.

These templates are some special preset presentation templates including color schemes and font formatting.  

Here the presentation tab comprises the wizard to help you through the process of creating your presentation.

(Fig 3.2)

(Fig 3.3)
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Adding Headers and Footers

Movies and Sounds in a presentation

Moving and copying objects

Similar to MS Word, you can add footers and headers to your presentations. 

To do so follow these steps:

1. Select the Header and Footer 

option from the Insert menu, 

then a Header and Footer dialog 

box will appear.

2. Now select the slide tab to add 

Date and time, Slide number, 

Header text and Footer text to 

add to a slide.

3. The Footer can be suppressed by 

clicking the Don't Show on title 

slide option.

4. Now click on Apply button for 

current slide and click on Apply to all button to add to every slide of presentation.

The movies and sound make our presentation slides interesting. Following steps can do it:

1. Select the slide that is used for sound etc.

2. Now from the Insert menu select the movies and 

sounds option.

3. Select the movies from Gallery option, and then the 

Microsoft Clip Gallery dialog box opens with the video 

tab.

4. Now select a video clip and press the play button to 

preview the movie and after confirm, click on insert 

button to insert the movie in the slide.

5. To add sounds, from Microsoft Clip Gallery select the sound tab and click on the play button to hear 

the sound.

6. If you confirm the selected sound, click on Insert button to insert the sound in the slide. 

To move an object to another place, follow these steps:

1. Select the object, which you want to move.

2. Now from Edit menu, select the cut option.

(Fig 3.4)

(Fig 3.5)
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3. The selected object is placed in clipboard.

4. In case to move the object to another presentation, open that 

presentation and select the related slide.

5. Now select the Paste option from Edit menu.

Alignment means to adjust the object to left, right or center. Or also the Top, 

Bottom or middle alignments can be used. There are many ways to align 

objects like:

In the slide, the objects are aligned with reference to other objects by using 

the align left, Align right etc. options present in the Align or Distribute 

submenu in the Draw button from the drawing toolbar.

To print a presentation, follow these steps:

Aligning Object

Printing a Presentation

1. Align objects with other objects

(Fig 3.6)

(Fig 3.7)
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1. From office button select the print option then the print dialog box will appear.

2. Now select number of slides per page option and click OK button.

To run a slide, follow these steps:

1. First select the view in which you want to 

run the slide like Slide, Outline etc.

2. Now from Slide show menu, select setup 

show option then a setup show dialog 

box will appear.

3. Now select all in slides portion and 

mention number of slides that you want 

to show.

4. Now select manually or using timings 

option from advance slides portion.

5. If you need not to use sounds and video 

files, select show without narration or 

show without animation check boxes.

A slide show can be made more effective if transition and timing is 

use when showing slides in a presentation. To do so, follow these 

steps.

1. Select animation menu of the presentation, select 

appropriate slide transition from the  slide transition 

dialog box.

Running a Slide Show

Setting Transitions and Slide Timings

(Fig 3.8)

(Fig 3.9)
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Exercise

1. Fill in the blanks :

2. State True or False :

3. Answer the following question :

1. The ___________option is used to blank presentation.

2. Alignment means to adjust the object to _____, _____ or ______.

3. Print option can be selected from _________ menu.

4. You can select setup show option from ________ menu.

1. Power point's template are designed by microsoft.

2. Select the Header and Footer option from edit menu.

3. Color scheme dialog box is used to change the pattern of a slide.

4. We can't use movies and sounds in a power point presentation.

5. Alignment means to align or adjust the object to left, right or center.

1. What is a template? Name the types of templates.

2. Write the steps to change the slide background.

3. Write the steps to change the slide layout.

4. What are the Header & Footers? Write the steps to add them in your presentation.

5. How can you insert pictures from files?

6. Write steps to cut or copy slide object in presentation.

7. How can you set slide transition and slide timings?
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Starting Ms-access 

Click on the Start Button

The Program menu will be displayed on the screen as illustrated

Select MS Access from the Program Menu as shown in figure 4.1.

You now get started with your Access Session.

The following screen will be displayed as soon as your Access Session is started, which asks for the various 

options. 

The starting screen is displayed as shown in the figure below.

Access database wizards, pages, and projects (this will also create a new database, by use of a wizard to 

give you a quick start.

Open an existing database – this will allow you to choose from a list.

Blank Access database (this will create a new container ready for you to fill in with various database 

objects.

Ø

Ø

Ø

·

·

·

Chapter - 4Chapter - 4 INTRODUCTION TO MS-ACCESS

(Fig 4.1)
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Depending on the task you want to do you can choose the appropriate option and perform the specified task.

It is said, “If data is lost, business is lost”. Data is very important to an organization.

Data is collection of raw facts and figures, which may consists of numbers, letters, events and transactions. It is 

like a raw material from which information will be extracted.

Database is a collection of related items grouped together under a single heading, for e.g. a customer file, A/C 

in a Bank, Employee Details etc.

A database can be said to be a collection of files containing records of similar nature. Each record contains all 

the data relating to one subject in the file. The grouping of such files is called a Database.  Database can be kept 

manually or electronically.

Example of database are telephone directory, dictionary etc. 

Ms Access Windows Components

Data

Database

“A Database is an organized store of data for computer processing.” 

(Fig 4.2)
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The various data types which available in the Access database are as follows.

By the help of tables we can make database. Creation of a table in any database is a most important part. In 

table, information is arranged in rows and columns. 

Tables are created inside the database, the table of database looks like your spreadsheet or school timetable as 

shown in figure 4.3. 

Each table holds related data to a particular subject.

What Are Tables, Form, Query And Report?

Table

       Data Type           Type of Data Stored Storage Size

Text Alphanumeric Characters 0 – 255 characters

Memo Alphanumeric Characters 0 – 64000 characters

Number Numeric Values 1,2,4, or 8 bytes

Date/Time Date and Time data 8 bytes

Currency Monetary data 8bytes

Auto Number Automatic number increment 4 bytes

Yes/No Logical values: Yes/No, 1 bit (0 or –1)

True/False

OLE Object Pictures, Graphs, Sound Up to 1 GB

Lookup wizard Displays data from another Generally 4 bytes

table

(Fig 4.3)
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Form 

Query

Form is to take data as a input for further processing. MS ACCESS also provides form to collect user information 

for processing. Form is used to enter, edit and view data in the table as shown in figure 4.4.

1. Data entry form: This type of form is used to enter data in a table.

2. Custom dialog box: To accept user input and than carry out an action based on that input 

3. Switchboard: This type of forms is used to open other forms or reports.

By the help of query we can ask any question and get the answer from the database.

For example you want to know how many students have got 90% in science as shown in figure 4.5.

Different Types Of Form

(Fig 4.4)

(Fig 4.5)
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Types Of Queries

Report 

Need for a Report

1. Simple query

2. Cross tab query

A report will print your database in a format which looks best on the paper using the printer attached to your 

computer. You can have the report displayed on the monitor too. These reports are generated by the queries 

using the information available in the tables. To present a data in front of a group or meeting etc., a person has 

to improve its look. This type of finalized document is known as a report.  

1. Presenting information in a customized way both onscreen and on paper.

2. Grouping and sorting data according to your needs and in order you want.

3. Calculating averages, fields totals, and drawing graphs.

You can now see the report, which you have made with the selected tables, forms or queries as in figure 4.6.

Reports are used for

(Fig 4.6)
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Creating New Database / Table

Creating A Database

To Create A New Database 

To create a new database, you can either select the option Blank Database from the opening dialog of MS 

Access, (remember that opening dialog appears when you start MS-Access) or you can click at command Office 

button New command. Following lines explain the steps for doing this.

1. On the database toolbar, click the New button as shown in (figure 4.7) or click on file menu, choose New 

figure 4.7.

2. Now the dialog box opens, in which click database under general tab. 

3. Click Ok. Now MS Access will ask you to specify the name for new database Specify the name and click 

create button.

4. You'll see that the blank database has been opened in the traditional window where you can create 

database objects like tables, forms etc.

(Fig 4.7)
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Creating A New Table

To Create A Table In Design View

Exercise

To create a new table, first display the database window. Then select the tables tab the (fig.) display three 

methods of table creation:

1. In the database window, click the tables tab.

2. Click the new button on the database window toolbar.

3. Click the new table dialog box, select design view 

4. Click OK.

5. Enter the field name and select a data type for each 

6. Add a description if you want. 

7. You can set field properties for each field.

1. In some databases ________________ are called views.

2. In __________ form Ms-Access keeps data in tables.

3. _____________ is used to present information in a customized way.

4. In ____________ view, you are directly able to enter data in a table.

5.  ____________ type of forms are used to open other forms or reports.

1. A dictionary is not a database.

2. The easiest way to create report is by using the wizard.

3. It is not possible to add a graphic or picture to a report.

4. Data is a collection of raw facts and figures.

5. Form is used to enter, edit and view data in the table.

1. What is data and database explain with example?

2. What is the use of query?

3. What is report? Why should you create a report?

4. What are data types in access, write names of data types?

5. What is a table?

6. What is the use of query; also write the types of query? 

7. How can you create a table in design view?

1. Fill In The Blanks :

2. State True Or Flase :

3. Question And Answers :



28

What Is Field 

Types Of Fields

Inserting New Fields

Data Filling

(Figure 5.1)

(Figure 5.1)

A field is a group of characters used to identify a particular database element.

A field is a data name given to specific type of data to store values in it. An element of a table that contains a 

specific item of information, such as a student name. Two properties are required for every field: field name 

and data type.

 name, age, class, address, salary etc.

Type of fields means the kind of information you would like to put in a field of a table.

It means the name, address are the examples of field of character data type and the fields like age, number, 

salary fall under the numeric values of data.

The steps involved in inserting a new field are as follows:

Place the cursor on the field before which you want to insert a new field

Select the Field option from the Insert menu

A new field is added to the table design.

To fill a table with data, you enter the data record by record. To complete each record, you enter information 

into the fields of the record. you can enter the data directly into the rows and column of the table.

1. Click on the Tables tab in the Database Window.

2. Click on the table name you want to add 

records. 

3. Click on the Open button. (You can also 

double – click the table icon). 

4. Click the new record button on the 

access toolbar to add a new record or you 

can just start typing in the last empty row, 

where mark is shown in its row selector.

Example :

Ÿ

Ÿ

Steps to enter data in a table

Chapter - 5Chapter - 5 INTRODUCTION TO MS ACCESS (contd.)

(Fig 5.1)
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5. Enter the data in the first field and then press tab to move to the next field.

6. If the field shows an error button, you can click the button to display the list and then select an entry in 

the list.

7. Press tab after the last field in the record to move to the start of a new record.

The record you have completed is saved automatically.

You can easily change the information in any field of any record.

To edit data follow these steps:

1. After opening the table in datasheet view, click any field in the table to position an insertion point in 

the field.

or double click any word or number in field to select it.

2. Make changes in data or type new data.

3. Click a different record to save the changes.

4. To replace the entry in a field with the entry in the same field of the previous record, click in the 

field and press (Ctrl + apostrophe).

In column if data is lengthy, you will have to change the width of the column to accommodate the data. Please 

follow these steps :

Place the cursor to change the width of the column

Place the mouse pointer on the dividing line between the columns.

The mouse pointer becomes a column-sizing tool.

Click and hold the left mouse button and drag the column border to the right to accommodate all 

your data .

Editing A Field Content

Changing Column Width

(Figure. 5.2)

Ø

Ø

Ø

Ø

(Fig 5.2)



(Fig 5.4)

(Fig 5.3)
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Selecting Rows And Columns

Figure.5.3.

Figure 5.4

To select rows and column follow these steps:

1. Click on field name, to select a column as shown in 

2. Click on the gray row button to select a complete record.

3. For select all the records, click on the gray square on the left of the first field as shown in .
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Moving Rows And Column 

Adding And Deleting A Record

Deleting Records

Adding And Deleting New Fields

Sorting Data

To move a column from one location to another, follow these steps:

1. Select the column, which you want to move by clicking on field name.

2. Now drag the mouse button to the location to move and release the mouse button.

3. Finally the selected field will be moved to desired location.

Once the table is opened in an active database, new records can be inserted into it. A new record contains the 

additional information and when added to the table, Access automatically saves it.

Place the insertion point on any record.

Click insert menu.

Click new record option 

The auto number field automatically inserts a number for the new record.

Click the first empty cell in the first row and type the data in each field of this newly inserted record.

You can delete a record by selecting the record and pressing the Delete Key. 

You can also choose the Delete option from the Edit menu. Multiple records can also be deleted selecting all 

the records to be deleted.

To add a field to your table, select the field before which the column is to be added.

Click on the insert menu.

Select the column option and click.

The new column will be added to the left of the selected column.

Select the field by clicking on the field selector (a button on the left of a field) and press the Delete key.

Select the field and then choose Delete from the edit menu.

Whenever you delete a field, you receive a warning from Access stating that you will lose all data stored in the 

field.

Sorting data means arranging data in alphabetically or numerically ascending (A to Z), (0 to 9) or descending 

(Z to A), (9 to 0) order. The sorting may be made on the records available in table, query or form. 

Ø

Ø

Ø

Ø

Ø

Ÿ

Ÿ

Ÿ

The steps involved in deleting a field are as follows :

Ÿ

Ÿ
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The following steps are to be taken for sorting records :

Exercise

1. Click anywhere in the field on which a sort is to be made in the records. 

2. Click one order at time to sort in ascending or descending order. The sorting as per given order instantly 

takes place. 

3. All the records according to the ascending order made on name field appear in the new order.

Filtering temporarily isolates a subset of records. This is particularly useful because the subset can be 

formatted and printed just like the entire datasheet. Filtering means to filter out all but the data you let pass 

your criteria. Access makes this operation as simple as sorting.

1. Click the Filter by Selection button on the toolbar for Customer table in the Northwind database.

2. Click the remove Filter button to remove the filter. Click the same button to reapply the filter.

3. Click the Remove Filter button to remove any filter by selection. Click the Filter by Form button. 

4. down buttons. Pull down the combo box for Contact Title and choose Accounting Manager. 

Click the Apply Filter button. This will apply the filter as before. You can filter on more than one field using 

this method.

Once you have filtered a datasheet to display a subset of records, you can still sort the records and find data just 

as if you were working with the entire datasheet.

1. ________________ is an elements of a table that contains a specific item of information.

2. You can delete record by selecting records and press _____________ key.

3. Filtering is temporarily used to isolate a ________________.

4. ______________ is the technique used to arrange data either in ascending or descending order.

5. The field option is in the _______________ menu.

1. Field name and data type are the properties of a field. 

2. The record you have completed is saved automatically.

Filters

Steps In Filtering 

1. Fill in blanks :

2. State True Or False :

Note the pull – 
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3. We cannot delete a record by clicking.

4. A record can be deleted by selecting and pressing delete key.

1. What are field? Write any three field names?

2. Write steps to insert a new field in a table?

3. How can you edit or change the contents of a field?

4. What are the steps to delete a record?

5. How can you sort the data of a table?

6. What are filters?

3. Question And Answers :
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FORMS

Introduction 

Form Layout Choices

Properly organized and well-designed forms increase productivity. Forms are the primary objects used to enter 

and edit data. Forms are often built to match a source document (for example, an employment application or a 

medical history form) to facilitate fast and accurate data entry. Now, however, it is becoming more common to 

type data directly into the database rather than first recording it on paper. When data is viewed in many ways, 

forms provide a great degree of flexibility for viewing and entering data. Though a datasheet also allow you to 

view many records at a time, the number of fields that can be seen is limited. Forms, on other hand can help 

you rearrange fields and view many more on a single screen.

Form design considerations, such as clearly labeled fields and appropriate formatting, are important. Other 

considerations include how the user tabs from field to field, and what type of control is used to display the data. 

1. Labels 

2. Text box 

3. List box 

4. Combo box 

5. Tab control 

6. Check box 

7. Toggle button 

8. Option button 

9. Bound Image control 

10. Unbound Image control 

11. Line and rectangle controls 

12. Command button 

1. Columnar Forms

2. Tabular Forms

3. Data sheet form

4.     Justified forms

Chapter-6Chapter-6 MS-ACCESS CONTINUED
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Columnar Forms

Tabular Forms

Data sheet form

Justified forms

Creating a Form

Using Auto Form Wizard to Create a Form

The fields are arranged as columns and resemble a manual data entry form.

The fields are arranged as columns and the records are entered in rows. Thus, it resembles a datasheet.

This type of form is normally used to arrange the form having rows and column to look like a table.

The justified layout of the form place the fields in equal rows across the form justified  on right and the left.

You can create a form from scratch using Form Design view, or you can use the Form Wizard to create an initial 

form object, which you can modify later if needed. The Form Wizard provides options for selecting fields, an 

overall layout, a style, and a form title.

1. Using the Auto Form feature.

2. Using the Form wizard.

3. Using the Design View.

1. Select the Form option in the Database window. Click on the New Object button in the Standard toolbar. 

Select Auto Form: Columnar from the New Form Window as shown below.

(Fig 6.1)
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2. Select the table or query on which you want to create a form.

3. A columnar form containing all the fields in the selected table or query is generated by Access. (In this case 

we are using Supplier table of the Northwind database)

4. Save this Form and close the form.

Like all Wizards, the Form Wizard simplifies the Layout of the fields. You are guided visually through a series of 

steps, which help you to decide on the type to be created, and then the form is created automatically.

The steps in creating a form through Form Wizard are as follows:

Select the Create menu.

Select the more Form tab and then click on the form wizard.

The New Form Dialog box is displayed as shown. You need to specify the table or query on which 

the form will be based, from the list of tables and queries. 

The New Form Dialog box gives you the following choices.

 is used to create a form with one of four layouts – columnar, tabular, or datasheet 

justified,  A step - by – step procedure guides you in customizing the form.

 is used to create a datasheet form.

 is used to create a tabular Form.

is used to create a columnar Form.

Creating Form with Help of Form Wizard

l

l 

l

l Form Wizard :

l Form Datasheet :

l Form Tabular :

l Form Columnar : 

(Fig 6.2)
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1. Select the fields that you want on your form and click Next button.

2. Choose the required layout and click Next button.

3. Select the form style and click Next button.

4. Type the name of the form in the text box and click Finish button.

The Form Design window is used to create a form without the help of the wizard. You need to open the relevant 

tables and include in the form. You can also add controls in the form, like text boxes, labels and option buttons.

1. Click on the Create Menu ® Form Design

The New Form dialog Box will be displayed as shown in the following figure. Here you have to specify the 

form that you have to create and the table or query on which the form will be based.

2. Select the Design Menu option and select the table or query name.

a. Insert commands to attach data fields design menu.

The field is placed at the desired position. The label for the field is the field name by default. A text box is 

automatically created at the time of drag and drop for the data entry into the field.

a. Select the control object from the toolbox once on it. Create the control by dragging the control in the 

detail section of the form. 

b. Size the box appropriately.

i. Select the control object.

ii. Click the right mouse button

iii. Select the properties option from 

the shortcut menu.

The properties window is displayed 

as shown below:

Designing a Form with design view

The Steps in creating a form in Design View are

Steps to add fields in a form are

The steps for creating control objects are 

The next step is to bind the control 

(Fig 6.3)
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Switch to the Data tab in the properties window.

iv. Click on the Control Source box and select the field in which you want to store the value selected in the 

control.

v. Click on the Row Source type and Select the table/Query option from the drop – down list.

vi. Click on the Row Source box and select the table or query name from which the values of the field will be 

looked up.

Making a form with the help of form wizard allows us to choice a background style for the making receive a 

number of option, you may select any one form clouds, dusk, flax, standard etc.

The figure given above is used to give name of the form like student and then decide to open the form to 

change the look of structure or to view or enter information in the form if desired.

Style Of Form

Name Of Form
(Fig 6.4)

(Fig 6.5)
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Header To The Form

Footer To The Form

Bound and Unbound Forms

You can create header to the form with the help of following steps:

1. Right click and select form Header and Footer.

2. By dragging sizing tool create some space for title and click on label button of toolbox.

3. Now put the cursor of mouse where you want to create a label.

4. Now select the label and hold down the mouse button and by dragging mouse pointer to draw a 

rectangular area in the header and release the mouse button.

5. Now you will see an insertion point and type the text for header.

You can create footer to the form with the help of following steps:

1. Right click and select form Header and Footer.

2. By dragging sizing tool create some space for title footer and click on label button of toolbox.

3. Now put the cursor of mouse  where you want to create a label.

4. Now select the label and hold down the mouse button and by dragging mouse pointer to draw a 

rectangular area in the footer and release the mouse button.

5. Now you will see an insertion point and type the text for footer.

A form can either be bound or unbound. A Bound form is linked to an underlying table or query and derives its 

data from and writes to that object. Unbound: Form neither gets data from nor writes to any object. The Record 

source property of a form controls what object, if any, is bound to a form.

(Fig 6.6)
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Controls are of following types:

Excersice

1. Bound Controls are linked to a field in a table. They are used to display a field value or accept values into a 

field. For example Text Boxes are controls that are used to enter values in a field.

2. Unbound controls are not linked to any field in a table. They are included in a form to enhance the display 

of a form. For example, the logo of a company can be displayed in a form. The logo, which can be a bitmap 

image, is an unbound control object.

3. Calculated: controls are based on expressions, such as functions. Calculated controls are also unbound, as 

they do not accept value in a field.

1. Chart wizard is used to _____________ a form with graph.

2. ________________ is used to create a columnar form.

3. Design view display a ________________that user need to design by adding fields.

4. Pivot table wizard is used to create an excel ___________.

5. Bound controls are ______________ to a field in a table.

1. Forms also can help to rearrange fields.

2. In the tabular forms Fields are arranged as columns and the records are entered in rows.

3. In the datasheet form is not normally used to arrange the form having rows and column to look like 

a table.

4. The justified layout of the form places the field in equal rows across the form justified on right and 

the left.

5. Auto form data sheet is not used to create a data sheet form.

6. Auto form tabular is used to create a tabular form.

7. Bound controls are linked to field in a table.

8. Unbound controls are not link to any field in a table.

1. What is form?

2. What are form layouts, briefly describe the forms of layouts?

3. Write steps to create a form with the help of wizard?

4. How can you select the style of a form?

5. Explain to add header and footer to form?

6. Write about bounds and unbounds?

1. Fill In The Blanks :

2. State True Or False :

3. Question And Answers :
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Introduction to Queries

What is a Query?

Types of Queries

Creating a Query

The primary purpose of DBMS is to provide accurate information in a custom format. The efficiency of a 

database is determined by the speed with which it retrieves data and presents it in a user – defined format. The 

process of accessing the database and retrieving data selectively is known as querying. Many developers call 

queries as the heart of Access. The data thus retrieved can then be formatted according to the users 

requirements.

A query is a database object that creates a datasheet of specified fields and records from one or more tables. A 

query displays the answer to a "question" about the data in your database. Although tables store all data it's 

the queries from which the vast majority of objects derive their data. Queries allow much more flexibility when 

selecting or manipulating data than the tables do. 

Access provides many different types of queries. They can be grouped into the following categories:

 is used to extract from tables based on criteria specified in the query object, and display 

the dynaset in Datasheet view. You can use query to display fields from more than one related tables.

 is used to display summarized values (sums, counts and averages) of both the rows and 

columns in the query.

Steps involved in creating a Query are shown below:

1. Click on create button

l Simple Query –

l Cross tab Query –

You can edit, navigate, sort, find, and filter a query datasheet just as you can a table datasheet. 
Because a query datasheet is a subset of data, it is similar to a filter, but much more powerful. One of the 
most important differences is that a query is a saved object within the database, which means that it does 
not need to be re-created each time you want to see that particular subset of data. A filter is a temporary 
view of the data whose criteria is discarded when you remove the filter or close the datasheet.

Chapter – 7Chapter – 7 QUERY IN MS ACCESS
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2. Click  on Query Design

3. Click on the Customers table and then click Add button to add this table to the Query.

4. Click Close to close the Show Table Dialog Box.

5.     Click and drag the first four fields (one at a time) from the Field list box and drop them in 

the first four columns. 

6. Click on the next field down – the Address. Then press Ctrl and click the next field City. This will select both 

the fields, then drag them to the grid and drop them to the right of the Contact Title field.

7. Click the Run button on the toolbar to see how the query is coming along. The Run button has an 

exclamation point.

(Fig 7.1)

(Fig 7.2)
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8. Save the Query and close the window.

1. Click queries wizard on the other toolbar and then double click Create Query by using Wizard.

When viewing a datasheet, you may want to display the data in some sorted order. You may want to sort the 

table to make it easier to analyze the data.

The Steps to sort records in the Datasheet view are:

1. Select the field to sort on by clicking on the field selector (the button on top of the column).

2. Select the Sort option from the Records menu.

3. Select the Sort order – ascending or descending.

If you want to change the sort order in the query design view, click on the sort box in the field column. Click on 

the downward – pointing arrow. Access displays the two sorting options. Select the appropriate sort Order.

Using criteria in queries to select only certain records is perhaps the most called –on use for queries. This 

facility is similar to filtering in Datasheet view. 

Every object in the database has a Design view in which you change the structure of the object. You can build a 

query directly in Query Design view, or you can let the Query Wizard help you. In either case, if you want to add 

criteria to limit or expand the number of records that you view in the datasheet, or if you want to change the 

fields you are viewing, you must use the query's Design view. 

Creating Query with Query Wizard

Sorting within a Query

Query Criteria

(Fig 7.3)
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Criteria placed on different rows of the query design grid are considered OR criteria. In other words, a record 

will be selected for inclusion in the query results if any one of the specified criteria is true. 

Placing additional criteria in the same row, however, is considered the AND criteria. In general, OR criteria 

broaden the query results, whereas AND criteria narrow the results.

To run the Query, follow these steps:

1. Select the Run option form the Query menu then access displays the results of the query in a datasheet. 

2. Now click the design view button to return to designing the query.

3. If no queries are open, double click a query to run it on the Query tab of the database window.

When designing Query in a Database, You can also add criteria to make the query more valuable. To do so 

follow these steps:

In the database window, select Query tab and click the design button.

1. In the Criteria cell of a field in the query design grid, write the number or text to match.

2. If you need help in constructing an expression, click in the criteria cell for a field and choose build button on 

the access toolbar.

Running the Query 

Adding Criteria to Window with Expression Builder 

(Fig 7.4)
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3. Then an Expression builder dialog box will appear, now you can type in the box at the top, click buttons to 

add the common operators and click the paste button to ad items from the submenu in the button section.

4. Now click OK button if you finished building the Expression.

5. Now click the Run button to view the results.

6. Click the design view button to return to designing the query and save the query design.

1. If we need help in making an Expression, we use _________ button on the access toolbar.

2. We select ___________ option from the ________ menu to display the results of the query in a 

datasheet.

3. Every object in the database has a Design View in which you change the ____________.

4. ___________ is used to arrange the data in a table in an ascending or descending order?

5. ___________ Query is used to display the summarized values.

1. Access provides many different types of Queries.

2. You can not create a query without wizard.

3. You can enter more records using Query.

4. A query is a database object that creates a datasheet of specified fields and records.

5. Every object in the database has a design view.

1. What is a query?

2. What are the types of query? Explain briefly.

3. What are the steps to create a Query using Wizard?

4. What are the Criteria in Query? Why are they essential?

5. What is Expression Builder and how it is related to Criteria in Query ?

Exercise

1. Fill in the blanks:

2. State True False:

3. Answer the following question :
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HTML stands for Hyper text markup language .It is a language by which we can create a web page. Hyper text 

refers to text attached with a hyperlink. A hyperlink is a link which is a executable path of another file and can be 

opened by clicking on them. So HTML is a language in which a webpage can be written.

A webpage is a html document containing information about the given topic in a stylish text, graphics and 

audio/video clips.

 A website is a collection of interlinked WebPages containing large volume of information in a combined way.

 Web server is powerful computer used to store large volume of data and serves to the clients on the request of 

the clients. A server takes requests from the clients and gives the responses to the clients.

 A html file can be created in the following way-

1. Using Notepad- Start notepad –type tags of HTML ( Covered Later)-save the file with any valid name 

and give the .html / .htm extension (svm.html).

or

2. Using Microsoft word- Type the content any thing you want-save it with .html/.htm extension

3. Using Front page of msoffice- start FrontPage-click on the file menu- new – create the document with 

or without hyper links-save it (front page automatically place the extension .html)

 HTML instructions are called html tags. A HTML tag is made up of a keyword covered by a set of angel brackets 

<> e.g. <html>, <br> <body> etc.

 An element is made up of a tag pair and enclosed displayable contents like 

<a> how are you !</a>

Webpage

Website

Web server

How to create a HTML file

TAG

ELEMENT

Chapter 8Chapter 8 HTML
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Some important TAGs and ELEMENTs are as follows with their usage-

e.g.

e.g.

<HTML> This HTML is a container element. The entire HTML document is contained within this element. The 

purpose of this element is to tell to the web browser that it is a html document. Every HTML document always 

starts with <HTML> and ends with </HTML>. HTML tags are not case sensitive so it can be written in capital or 

small letters.

<HTML>

</HTML>

 HEAD element is a container element which contains many other sub elements. It is an optional element but if 

it is presented in the document that must be after <HTML> tag. It is also called Header element.

 A title is top line of the web page which shows the name and purpose of the Website. A title can be defined by 

the <TITLE> tag of the html and must be end with </TITLE>

This is the largest element of the document. It contains all the content that is there to be displayed in the 

browser. It is a container element which may contain many other tags-

<html>

<head>

<title>My first web page</title>

</head>

<body>

This is my first web page

</body>

</html>

HEAD

TITLE

BODY



48

Attributes of Body <BODY>

1. BACKGROUND-

2. BGCOLOR-

3. TEXT, LINK, ALINK, VLINK -

4. FONT-

5. SIZE- 

This attribute specifies an image or color to be included as background of the page 

body. <BODY background=”pic1.jpeg”>

 This attribute specifies the color of the bacjground of the page. A page color is formed with 

RGB( Red , Green, Blue ) colors. <BODY BGCOLOR=”RED”>

 These attributes specify the colors of the texts,hyperlinks,active links and 

visited links respectively.   <BODY BGCOLR=”RED” TEXT=”GREEN” LINK=”YELLOW” ALINK=”BLUE” 

VLINK=”RED”>

 This tag allow the designer to set font of the text.

This attribute allow the user to set the size of the text..

<BODY >

<FONT SIZE=2>saraswati vidya mandir</FONT>

</BODY>



49

Paragraph 

Line breaks

Headings

The paragraph tags are used to define a block of text as a paragraph. This HTML element is one of the basic 

HTML tags you can use properly using <p>   </p>.

<p>This is my first web page</p>

<p>Saraswati</p>

The p tag is for paragraph.

The line-break tag can also be used to separate lines like this:

This is my first web page<br />

However, this method is over-used and shouldn't be used if two blocks of text are intended to be separate from 

one another (because if that's what you want to do you probably want the p tag).

Note that because there's no content involved with the line-break tag, there is no closing tag and it closes itself 

with a "/" after the "br".

Heading tags are used to define the headings in your page. There are 6 level available, h1 set of heading tags 

being the biggest and boldest and the h6 set being the smallest.

Change your code to the following:

<html>

<head>

<title>My first web page</title>

</head>

<body>

e.g.

e.g.

< > </ >

< > </ >

< > </ >

< > </ >

< > </ >

< > </ >

h1 h1

h2 h2

h3 h3

h4 h4

h5 h5

h6 h6

Heading level 1

Heading level 2

Heading level 3

Heading level 4

Heading level 5

Heading level 6
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</body>

</html>

Figure- Heading

HTML lists are bulleted or numbered lines of text. There are actually three different types of HTML lists, 

including unordered lists (bullets), ordered lists (numbers), and definition lists (dictionaries).

e.g.

<html>

<head>

<title>My first web page</title>

</head>

<body>

<ul>

Lists-
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<li>Sultanpur</li>

<li>Lucknow</li>

<li>VidyaBharti</li>

</ul>

<ol>

  <li>Sultanpur</li>

  <li>Lucknow</li>

  <li>VidyaBharti</li>

</ol>

<dl>

  <dt><b>Sultanpur</b></dt>

    <dd>Lucknow</dd>

  <dt><b>VidyaBharti</b></dt>

    <dd>UttarPradesh</dd>

  </dt>

</dl>

</body>

</html>

Figure- Example of List
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Images- 

Image Attributes:

Images are very important to beautify as well as to depicts many concepts on your web page. Its is true that one 

single image is worth than thousands of words. So as a Web Developer you should have clear understanding on 

how to use images in your web pages.

<IMG SRC="image.gif" ALT="some text" WIDTH=32 HEIGHT=32>

 sets width of the image. This will have a value like 10 or 20%etc.

 sets height of the image. This will have a value like 10 or 20% etc.

 sets a border around the image. This will have a value like 1 or 2 etc.

specifies URL of the image file.

 this is an alternate text which will be displayed if image is missing.

 this sets horizontal alignment of the image and takes value either left, right orcenter.

 this sets vertical alignment of the image and takes value either top, bottom orcenter.

 horizontal space around the image. This will have a value like 10 or 20%etc.

 vertical space around the image. This will have a value like 10 or 20%etc.

 name of the image with in the document.

 id of the image with in the document.

 this will be used if you are using CSS.

specifies a text title. The browser, perhaps flashing the title when the mouse passes over the link.

e.g.

<html>

<head>

<title>My first web page</title>

</head>

<body>

<img src="pic1.jpeg" alt="HTML Tutorial" width="100" height="100" 

border="2" align="right" title="HTML Tutorial" />

</body>

</html>

Width-

Height-

Border-

Src-

Alt-

Align-

Valign-

Hspace-

Vspace-

Name-

Id-

Style-

Title- 
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Table- 

The HTML table model allows authors to arrange data -- text, preformatted text, images, links, forms, form 

fields, other tables, etc. -- into rows and columns of cells.

<HTML>

<BODY>

<table border=2>

<tr>

<td>Row 1, cell 1</td>

<td>Row 1, cell 2</td>

<td>Row 1, cell 3</td>

</tr>

<tr>

<td>Row 2, cell 1</td>

<td>Row 2, cell 2</td>

<td>Row 2, cell 3</td>

</tr>

<tr>

<td>Row 3, cell 1</td>

<td>Row 3, cell 2</td>

<td>Row 3, cell 3</td>

</tr>

<tr>

<td>Row 4, cell 1</td>

<td>Row 4, cell 2</td>

<td>Row 4, cell 3</td>

</tr>

</table>

</body>

</html>



The table element defines the table.

The tr element defines a table row.

The td element defines a data cell. These must be enclosed in tr tags, as shown above.

If you imagine a 3x4 table, which is 12 cells, there should be four tr elements to define the rows and three 

td elements within each of the rows, making a total of 12 td elements.

1. What is Web page?

2. What is Website?

3. What is Web server?

4. What are different attributes of body tag?

5. What are different attributes of image tag?

6. Mention different levels of headings.

7. What is list ? mention its type.

Exercise

Answer the following question :
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Threats are those factors that results in harmful effects on computers 

1. Hardware threats

2. Software Threats

3. Intrusion Threats

It occurs due to failure of hardware component and results in loss of important information. Hard disk and 

power supply are more prone to hardware threats.Some reason that can cause damage of hardware 

components are 

1. When hard Disc gets old.

2. Low voltage at electrical outlet

3. Sudden increase in voltage 

Harmful effects of threats can be reduced by using uninterrupted power supply and   taking regular backup of 

important information. 

 Software threats can be general problems or an attack by one or more types of malicious programs. like virus , 

Trojan horses and worms are very harmful  and  corrupt important informations.

It is a malicious program that destroys or corrupt important data from your computer. 

They spread by attaching themselves to files, they can also replicate.

 It is a non-self-replicating type of malware which desirable function but 

facilitates unauthorized access to the user's computer system. themselves into other files like a 

Trojan horses may steal information, or harm their host computer systems.

 are computer programs that replicates itself in order to spread to other computers. 

Often, it uses a computer network  to spread itself Worms almost always cause at least some 

harm to the network, even if only by consuming band width

At Times  human beings with malicious intention can also create serious threats it is due to accessing 

confidential information illegally.

 In this user gets access to sensitive information like credit cards No., passwords etc 

this is done by sending fake Emails and instant messages.

 It is a method by which user accesses computer for which he is not authorized.Hacker 

use their knowledge about computer for playful pranks.

Types of threat

Hardware Threats

Software Threats

Intrusion Threats

1. Virus : 

2. Trojan horse or Trojan :

3. Worms :

1. Phishing :

3.   Hacking :

Chapter – 9Chapter – 9 COMPUTER THREATS AND SECURITIES
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Security Measures

1. Fill in the Blanks :

2. State true or False :

3. Answer the following question :

Following are some important security measures to be taken for protecting computer

 It is the process of verifying whether the person wanting to use computer is 

legal user or notThis can be done by providing valid username and passward and after 

verifying details user is allowed to log in and use computer.

 It is a conversion of data into a form that cannot be understood by unauthorized 

people this text is called ciphertext.Example Digital Signature.

It is opposite to Encryption It is the process of decoding original information from 

Ciphertext

 It is a computer program that detects , prevents and remove harmful 

programs. Some examples of antivirus are Kaspersky, MaCafee etc.

 It is a powerful security program that prevents unauthorized access to computer on 

the network.

1. Crushing of computer is __________type of threat.

2. __________spread themselves by attaching themselves to files.

3. __________use their knowledge for playful pranks.

4. __________remove harmful programs.

5. A _________is a program designed to replicate.

1. It  is necessary to take backup of important files regularly.

2. Virus do not harm computer.

3. FireWall is self replicating program.

4.  Decryption  is the process of decoding original information from Ciphertext.

5. You must tell your password to Everybody.

1. What do you understand by threats Explain?

2. Explain different types of threat on computers?

3. Explain with Example software threats ?

4. What are the different security measures that prevent your computer from unauthorized 

access?

5. Differentiate between Encryption and Decryption ?

6. What are the various reasons that can cause damage to hardware ?

1. Authentication :

2. Encryption :

3. Decryption : 

4. Antivirus Softwares :

5. FireWall :

Exercise
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We have to provide the computer with a set of instructions to solve the problem at hand. This set of 

instructions called a Program. In other words, the specification of the sequence of computational steps in a 

particular programming language is termed as a program. The special notations which are understood by the 

computers (for the specification of such a sequence of computer steps) known as programming language.

So the task of developing programs is called Programming and the person engaged in programming 

activity is called Programmer.

Before writing a program one must first plan the program. That is to write a correct and effective 

computer program we must first plan its logic. Before learning how to write a computer program, we will first 

learn how to plan its logic. That is we have some programming techniques to write the logic. They are given as 

follows -

An algorithm is the first steps in problem solving. The term algorithm refers to description of how to 

arrive at a solution to a given problem.

To write an algorithm we must follow the given characteristics -

1. Each step in algorithm should be clear and unambiguous.

2. Algorithm should be most effective among many different ways to solve a problem.

3. An algorithm shouldn't have computer code. Instead, the algorithm should be written in such a way 

that, it can be used in similar programming languages.

Write an algorithm to add two numbers.

Step 1 - Start

Step 2 - Read the two numbers A & B

Step 3 - Add A & B and store it in C

Step 4 - Print C

Step 5 - Stop

Algorithm :

Example 1 :

Solution -

Chapter – 10Chapter – 10 PROGRAMMING



Example 2 :

Write an algorithm to find whether a given number is odd or even.

Solution -

Step 1 - Start

Step 2 - Read the number N

Step 3 - Divide the number by 2

Step 4 - If the reminder of the division is Zero, then the number is even else the number is odd.

Step 5 - Stop

"A flowchart is a pictorial representation of an algorithm."

Programmers often use it as a program planning tool for visually organizing a sequence of steps 

necessary to solve a problem using a computer. It uses boxes of different shapes to denote Different types of 

instructions. Programmers write actual instructions within these boxes using clear and concise statements 

directed solid lines connecting these boxes indicate flow of operations sequence in which to execute the 

instructions. The process of drawing a flowchart for an algorithm is known as Flowcharting.

 Normally, we first represent an algorithm as a flowchart, and then express the flowchart in a 

programming language to prepare a computer program. By writing Algorithm and flowchart, a programmer 

can concentrate fully on the logic of the solution to the problem at hand without paying attention to the syntax 

and other details of programming language. Since a flowchart shows the flow of operations in pictorial form, a 

programmer can detect any error in the logic with greater ease than in the case of a program.

Terminal

Input/Ourput

Processing 

Decision

Flow Chart :  

Why use Flowchart ?

Flowchart Symbols :
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Flow line

Connectors

 Draw a flowchart to find the sum of two numbers -

Start

Read  a.b

c=a+b

Print c

Stop

The Flow of logic in a program can be explained as a following structures -

1. Sequence/Linear

2. Selection/Branching

3. Iteration/Looping

Sequence programs is given in above example. It is a step in straight logic. It involves no 

representation or Alphabet sequence of steps.

Branching is the process of two or more alternate paths of computation to understood 

branching consider the following examples.

Rule for Developing Flow Charting :

Sequence :  

Branching :  

Example 1 :
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Example :

Example : 

Draw the Flow chart check that given no. Even or Odd.

Start

Read a

R = a%2

No Yes
If R = 0

Given number is odd Given number is Even

stop

"Looping refers to using one or more steps repeatedly" Loops are two types -

1. Fixed

2. Variable

Draw a Flowchart to print "Hello" ten lines.

Start

Count = 0

Print "Hello"

Count = Count + 1

No
If 

Count  = 10

 
Stop

Looping :  

Yes
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The above example illustrated a fixed loop because the total number of print the statement is fixed that 

is ten times. The given loop cannot be executed more than ten times.

Draw a Flowchart to print 1 to 10 numbers.

Start

N = 1

Print N

N = N + 1

No
If 

N> 10

 
Stop

The above example illustrated a variable loop because we do not know the exact number of iteration 

this loop continues fill the user wants to continue.

1. It is easier for the programmer to explain the logic of a program to others.

2. We can easily detect any problem or error by using the flowchart.

3. Once a flowchart is ready, programmers can easily write the program because the flowchart acts as a road 

map for them.

a) Diamond shape is used to ___________ in the flow chart.

b) _________ are represented by the circle.

c) __________ can only come out from start box.

d) Task of developing program is called _________

Example : 

Advantage of Flow chart : 

Exercise

1. Fill in the Blanks :

Yes
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2. State true or False :

3. Answer the following question :

a) There may be more than one way to solve a problem ( )

b) The flowchart is a diagram which is not visually presents the flow fo data. ( )

c) All boxes of the flowchart are connected with lines. ( )

d) Yes instruction should repeat infinitely in Algorithm. ( )

e) Algorithm is a pictorial representation of a Flowchart. ( )

a) Define the Algorithm? Give some example.

b) What is Flowchart? Explain the symbols of Flow chart.

c) Write the Characteristics of Algorithm?

d) Write the Step of Algorithm and Draw a flowchart to find the sum of five numbers?
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C is most popular computer programming language. It is a structured, High-Level, Machine 

Independent language. It allows software developers to develop programs without worrying about the 

hardware platforms where they will be implemented.

Fist programming language is ALGOL, introduced in the early 1960's. In 1967, Martin Richards 

developed a language is called BCPL (Basic Combined Programming Language) for writing system software. In 

1970 Ken Thompson created B language using many features of BCPL.

C was evolved from ALGOL, BCPL and B by Dennis Ritchie at the Bell Laboratories in 1972. C uses many 

concepts from these languages and added the concept of data types and powerful features. 

Since it was developed along with the UNIX operating systems, it is strongly associated with UNIX.

In 1983 ANSI (American National Standard Institute) appointed a technical committee to define a 

standard for C. The committee was approved a version of C in December 1989 which is known as ANSI C. It was 

then approved by the International Standard Organization (ISO) in 1990. 

1960 ALGOL International Group

1967 BCPL Martin Richards

1970 B Ken Thompson

1972 Traditional C Dennis Richie

1978 K & R C Kernighan and Richie

1989 ANSI C ANSI Committee

1990 ANSI/ISO C ISO Committee

The C compiler combines the capabilities of an assembly language with the features of a high-level 

language and therefore it is well suited for writing both system software and business packaged.

Programs written in C are efficient and fast. It is many time faster than BASIC. For example : a program to 

increment a variable from 0 to 15000 takes about one second in C while it takes more than 50 seconds in BASIC.

C is highly portable. It means C programs are written for one computer can be run on other with little or 

no modifications.

Develop of C

Importance of C

Chapter – 11Chapter – 11 INTRODUCTION OF 'C'



Extensive variety of operators & data types.

Permits the solving of multitude problems with minimum efforts.

 There are used many words, character or special symbol in C Language. All those letters which 

approved in C Language. The collection of all those letters, special symbol is called character set. The character 

are presented following.

Alphabet : A, B, C, D, E, F, G, H, I, J, K, L, M, N, O, P, Q, R, S, T, U, V, W, X, Y, Z

a, b, c, d, e, f, g, h, i, j, k, l, m, n, o, p, q, r, s, t, u, v, w, x, y, z

Digits : 0, 1, 2, 3, 4, 5, 6, 7, 8, 9

Special Symbol : ~, !, @, #, $, %, Ù, &, *, (, ), -, +, |, ?, /, >, <, \

Every C word is classified as either a keyword of an identifier. All keywords have fixed meanings and 

these cannot be changed. Keywords must be written in lowercase.

auto break case  char

const continue default do

double else enum extern

float for goto if

int long register return

short signed sizeof static

struct switch typedef union

unsigned void volatile while

Identifiers refer to the name of variables, function and arrays. These are user- defined names and 

consist of a sequence of letters and digits, with a letter as a first character. Both uppercase and lowercase 

letters are commonly used. The underscore character is also permitted in identifiers. It is used as a link 

between two words in long identifiers.

The first letter must be an alphabet or an underscore ( _ ).

Upper case and lowercase variables are different.

It should not be a keyword.

Blank spaces are not allowed with in a variable name except underscore.

Length should not be more than 31 characters.

Character Set :

Keywords :

Identifiers :

Rules for Identifiers :

ANSI Keywords :

l

l

l

l

l
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Variables :

Declaration of Variables :

Constant :

Data Types :

Void Data Type :

Operator :

Main C  operators :

 

A variables is a data name that may be used to store a data value. A variable may take different values at 

different times during execution. A variable name can be chosen by the programmer in a meaningful way so as 

to reflect it function or nature in the program.

A variables can be used to store a data value of any data type. The syntax for declaring a variable is a 

follows :

data_type vari 1, Vari2, ...........varin;

Constants refer to fixed values that the program may not alter during its excution. These fixed values 

are also called literals. Constants can be of any of the basic data types like an integer constant, a floating 

constant, a character constant, or a string literal. There are enumeration constants as well.

C  language is rich in its data types. The varieties of data type available allow the programmer to select 

the type appropriate to the needs of the application as well as the machine.

All C compilers support five basic data types, namely integer (int), character (char), floating point 

(float), double-precision point (double) and void. Many of them also offer extended data types such as long 

double and long int. The range of the basic data types are given below.

char (1 byte) -128 to +127 %c

int (2 byte) -32768 to +32767 %d

float (4 byte) -3.4e-38 to 3.4e+38 %f

double (8 byte) 2.3E-308 to 1.7E+308 (15 decimal places) %1f

The void type has no values. This usually used to specify the type of functions. The type of a function is 

said to be void when it does not return any value to the calling function.

An operator is a symbol that tells the compiler to perform a certain mathematical or logical 

manipulation. Operators are used n programs to manipulate data variables. C language supports a rich set of 

built in operators.

It used to perform arithmetic operation like as addition, subtraction, multiplication, 

division etc.

Data Type Range of values Module

Arithmetic Operators :
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Operator Work

Operator Work

Operator Work Example

Operator Work Example

+ Adds two operands

- Subtract second operands from first

* Multiply two operand

/ Divide numerator by denominator

% Reminder of division

It is used to express relation between two variables like as B is less than 100, C  is 

greater than B, N is equal 50 etc.

== Check if two operand are equal

!= Check if two operand are not equal

> Check if operand on the left is greater than operand on the right

< Check if operand on the left is smaller than right operand

Assignment Operator is used to assign the value in a variable. It assigns tht right side 

value to left side variable or name.

= Assigns values from right side operands

to left side operand a=b

+= Adds right operand to the left operand a+=b is same as a=a+b

and assign the result to left

-= Subtracts right operand to the left operand a-=b is same as a=a-b

and assign the result to left

It is used to combine two or more expression in logical way.

&& Logical AND (a && b) is false

|| Logical OR (a || b) s true

! Logical NOT (!a) is false

'C' program can be viewed as a group building block called functions. A function is a subroutine that 

may include one or more statement designed to perform a specific task. A 'C' program may contain one or more 

section.

The documentation section consists of a comment lines giving the name of the 

program, the author and other details. 

The link section provides the instruction to the compiler to the link functions from the 

system library.

Relational Operators :

Assignment Operators :

Logical Operators :

a) Documentation Section :

b) Link Section :

 

 

 

Basic Structure of C  Program :
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e) Pre Processor Directive :

d) Definition Section :

e) Main () function :

f) Header file :

g) Code Block :

 

 

 

 

 

Statement Terminator : 

Comments : 

A Sample Program : 

These are the instructions which instruct the compiler to program the specified 

task before compiling the program.

The Definition Section defines all symbolic constants.

Every 'C' program must have main function. The section contains two part, 

DECLARATION PART and EXECUTABLE PART. The declaration part declares all the variables used in the 

executable part. Every program execution begins at the opening brace '}' and ends at the closing brace '}' of 

the main program.

These are special file of 'C', also known as library files. These file contain definitions of 

commonly used functions which are used by main function to perform specific tasks. Example - stdio.h, 

conio.h, math.h, etc.

A logical collection or group of statement which achieves a specified task is called block in C. A 

group of statement within parentheses can be viewed as a block.

{

___________________

___________________

___________________

}

Every statement is terminated with a semicolon ( ; ).

Comment are usually the explanations written for programmer's own convenience.

/*This is comment*/ A Comment

#include<stdio.h> Link Section

#include<coino.h>

void main() main function

{

Int x, y, z; declarations

x=5;

y=10;

z=x+y; executable statement

printf("%d", z);

getch();

}
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Exercise

1. Multiple Choice Questions:

2. Fill in the Blank :

3. Question and Answer :

a) C program was created in year-

(i) 1972 (ii) 1980

(iii) 1976 (iv) 1967

b) C programming  was created at .............. by Dennis Ritchie.

(i) MIT University (ii) L & T Laboratory

(iii) Howard University (iv) Stanford Lab

c) C programs are converted into machine language with the help of -

(i) An Editor (ii) A Compiler

(iii) An Operating System (iv) None of the above

d) Which data type capacity is 8 byte-

(i) char (ii) int

(iii) double (iv) void

a) First programming language is ____________

b) The void data type has no __________

c) Every statement is terminated with a __________

d) All the __________ must be written in lowercase letter.

a) Write the feature of C  Language?

b) What is identifier? Give of some example.

c) What is variable?

d) Explain the operator in 'C'?

e) Briefly explain the history of  'C'?
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Character form of decimal digit, Binary patterns are used to represent more than just numbers. They 

can be for characters, text, sounds and images. All the characters on the keyboard can be given a character 

code which can be represented as a binary pattern inside the computer.

Computer performs all his works in binary number system. It is necessary to convert in binary format of 

all type of data (number, character, words) after store computer. There are used different types of computer 

code to convert original data into binary data. Some computer code are given following-

1. BCD Code

2. ASCII Code

3. EBCDIC Code 

BCD stands for Binary Coded Decimal. It is used to convert decimal number to binary number to store in 
4computer memory. It is one of the first developed memory code. It is a four bit code. It can represent 2  = 16 

different characters. In this code every decimal number has been represented into four binary bits.

0 0000

1 0001

2 0010

3 0011

4 0100

5 0101

6 0110

7 0111

8 1000

9 1001

Decimal Number (52)  would be represented in BCD.10

52 = 5 210

0101 0010

So 52 = 0101  001010 2

 would be written in BCD Code.

165 = 1 6 510

0001 0110 0101

So 52 = 0001  0110   010110 2

BCD Code :

Decimal Number Code 4 Bit BCD

Example 1 :  

Example2 : (165)10

Chapter – 12Chapter – 12 CHARACTER REPRESENTATION



ASCII Code :

EBCDIC Code :

It is most commonly uses computer code. It stands for American Standard Code for Information 

Interchange. It was developed by American National Standard Institute in 1963 for Encoding. There are many 

computer architect  company who selected the ASCII Code for their computer. It is mostly used computer code 

today. There are two types of ASCII Codes.

1. ASCII-7

2. ASCII-8

7
Ascii-7 can encode 2 =128 different character. In this coding system first three bit has been 

represented zone bit from 7 bits and last four bit becomes value of character.

8
Ascii-8 can encode 2 =128 different character. In this system first four bit has been represented zone 

bit from 8 bits and last four bit becomes the value of character.

Decimal (24)  would be represented in seven bit codes.10

2 011  0010

4 011  0100

Decimal (153)  would be represented in eight bit codes.10

A 1010 0001 A1

B 1010 0010 A2

C 1010 0011 A3

BCD Code is a 6 bit code that may encode maximum 64 characters. This range of data representation is 

very low because there are more character and symbol are used in computer. For example Decimal Number, 

lower case alphabet, upper case alphabet, special symbol (, ), %, $, #, -, +, *, ¸ etc. In this way to increase the 

range of 6 bit BCD Code. IBM developed EBCDIC Code. EBCDIC Code stands for extended Binary Coded Decimal 
8Interchange Code. EBCDIC Code is 8 bit code which can represent 2 =256 different character in binary. The first 

four bit is zone bit from 8 bits and last four bits are binary value of character.

Character    EBCDIC CODE Hexadecimal Equivalent

Zone Bit Digit

A 1100 0001 C1

B 1100 0010 C2

C 1100 0011 C3

ASCII-7 : 

ASCII-8 : 

 

 

Example  : 

Example  : 

Character ASCII-7 Bit

Character     ASCII-8 CODE Hexadecimal Equivalent

Zone Bit Digit
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Binary Arithmatic

Binary Addition 

Binary Subtraction 

 Binary arithmetic is essential part of all the digital computers and many other digital system. Arithmetic 

in binary is much like arithmetic in other numeral system. Addition, subtraction, multiplication and division can 

be performed on binary numerals.

It is a key for binary subtraction, multiplication, division. There are four rules of binary addition. The 

simplest arithmetic operation in binary is addition. Adding two single-digit binary numbers is relatively simple, 

using a form of carrying :

0 + 0 ® 0

0 + 1 ® 1

1 + 0 ® 1

1 + 1 ® 0,   carry 1 (since 1 + 1 = 2 in decimal number )

Adding two "1" digits produces a digit "0", while 1 will have to be added to the next column. Carrying 

works the same way in binary as decimal.

   1  1  1  1  1 (carried digits)

       0  1  1  0  1

+     1  0  1  1  1

     1  0  0  1  0  0  = 36

In this example, two numerals are beings added together : 01101  (13)  and 10111  (23) . The top row 2 10 2 10

shows the carry bits used. Starting in the rightmost column, 1 + 1 = 10 . The 1 is carried to the left, and the 0 is 2

written at the bottom of the rightmost column. The second column from the right added: 1 + 0 = 10  again; the 1 2

is carried, and 0 is written at the bottom. The third column: 1 + 1 + 1 = 11 . This time, a 1 is carried, and a 1 is 2

written in the bottom row. Proceeding like this give the final answer 100100  (36 decimal).2

The top row shows the carry bits used. Instead of the standard carry from one column to the next, the 

lowest-ordered "1" with a "1" in the corresponding place value beneath it way be added and a "1" may be 

carried to one digit past the end of the series. The "used" numbers must be crossed off, since they are already 

added. Other long strings may likewise be cancelled using the same technique. Them, simply add together any 

remaining digits normally. Proceeding in this manner gives the final answer of 1 1 0 0 1 1 1 0 0 0 1  (1649) . In 2 10

our simple example using small numbers, the traditional carry method required eight carry operations. Yet the 

long carry method required only two, representing a substantial reduction of effort.

Subtraction and Borrow,  these two words will be used very frequently for the binary subtraction. There 

are four rules of binary subtraction.

0 - 0 ® 0

0 - 1 ® 1,   borrow 1

1 - 0 ® 1

1 - 1 ® 0,   
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Subtracting  a "1" digit from a "0" digit produces the digit "1", while 1 will have to be subtracted from 

the next column. This is known as borrowing. The principle is the same as for carrying. When the result of a 

subtraction is less than 0, the least possible value of a digit, the procedure is to "borrow"  the deficit divided by 

the radix (that is, 10/10) from the left, subtracting it from the next positional value.

     *     *   *  *     (starred columns are borrowed from)

   1  1  0  1  1  1  0

-       1  0  1  1  1

=   1  0  1  0  1  1  1

    *      (starred columns are borrowed from)

  1  0  1  1  1  1  1

-   1  0  1  0  1  1

=  0  1  1  0  1  0  0

Subtracting a positive number is equivalent to adding a negative number of equal absolute value. 

Computers use signed number representations to handle negative numbers - most commonly the two's  

complement notation. Such representations eliminate the need for a separate "subtract" operation. Using 

two's  complement notation subtraction can be summarized by the following formula.

Binary multiplication is similar to decimal multiplication. It is simpler than decimal multiplication 

because only 0s and 1s are involved. There are four rules of binary multiplication.

0 x 0 = 0

0 x 1 = 0

1 x 0 = 0

1 x 1 = 1

For example, the binary numbers 1011 and 1010 are multiplied as follows:

     1  0  1  1 (A)

       x   1  0  1  0 (B)

         0   0   0   0 Corresponds to the rightmost 'zero' in B

+     1   0   1   1 Corresponds to the next 'one' in B

+    0   0   0   0

+  1   0   1   1

    1  1  0  1  1  1  0

Binary division is similar to decimal division. It is called as the long division procedure. Long division in 

binary is again similar to its decimal counterpart.  

In the example below, the divisor is 101 , or 5 decimal, while the dividend is 11011 , or 27 decimal. The 2 2

procedure is the same as that of decimal long division; here, the divisor 101  goes into the first three digits 110  2 2

of the dividend one time, so a "1" is written on the top line. This result is multiplied by the divisor, and 

Binary Multiplication

Binary Division
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subtracted from three digits of the dividend; the next digit (a "1") is included to obtain a new three-digit 

sequence :

1

1 0 1  ) 1  1  0  1  1

        - 1  0  1

         0  0  1

The procedure is then repeated with the new sequence, continuing until the digits in the dividend have 

been exhausted :

             1  0  1

1 0 1  ) 1  1  0  1  1

        - 1  0  1

           1  1  1

  1  0  1 

     1  0

Thus, the quotient of 11011  divided by 101  is 101 , as shown on the top line, while the remainder, 2 2 2

shown on the bottom line, is 10 . In decimal, 27 divided by 5 is 5, with a remainder of 2. 2

a) Computer performs all his works in  ________  number system.

b) The first four bit is ______ bit from 8 bits and last four bits are ______ value of character.

c) Ascii stand for  __________ .

d) IBM developed on  _____________ .

a) 1 1 1 1  +  1 0 1 0

b) 1 0 1 0  +  1 1 0 1

c) 1 0 0 1  -  1 0 1 1 

d) 1 1 1 0  -  1 0 0 1

e) 1 0 1 0  *  1 1

f) 1 1 1 1  *  1 0  1

g) 1 0 1 0 / 1 0

h) 1 1 0 1 / 1 1 

Exercise

1. Fill in the Blank :

2. Solve the following:



Microsoft Word Shortcut Keys
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Microsoft Excel Shortcut Keys   
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Microsoft Power Point Shortcut Keys  
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Access Shortcut Keys

Bold

Ctrl-F2

Ctrl-B
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